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This learning guide was developed to provide you the necessary information regarding the 

following 

o Basic Design Principles 

o Opening And Designing  Database Application  

o Database Object 

o Creating Database Object 

o Modifying Database Object  

o Creating Relationship 

o Adding, Modifying And Deleting Records  

o Saving And Compiling Database Objects  

 This guide will also assist you& you will be able to  

o Know Basic Design Principles 

o Opening And Designing  Database Application  

o Database Object 

o Modify Database Object  

o Create Relationship 

o Add, Modify And Delete Records  

o Save And Compile Database Objects  

Learning Instructions 

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described in number 3 to 34.  

3. Read the information written in the ―Information Sheets 1‖. Try to understand what are 

being discussed. Ask you teacher for assistance if you have hard time understanding 

them. 

4. Accomplish the ―Self-check 1‖ in page 7.  

5. Ask from your teacher the key to correction (key answers) or you can request your 

teacher to correct your work. (You are to get the key answer only after you finished 

answering the Self-check 1). 

6. If you earned a satisfactory evaluation proceed to ―Information Sheet 2‖.  However, if 

your rating is unsatisfactory, see your teacher for further instructions or go back to 

Learning Activity #1. 

7. Submit your accomplished Self-check.  This will form part of your training portfolio. 

8. Read the information written in the ―Information Sheet 2‖. Try to understand what are 

being discussed. Ask you teacher for assistance if you have hard time understanding 

them. 
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9. Accomplish the ―Self-check 2‖ in page 10.  

10. Ask from your teacher the key to correction (key answers) or you can request your 

teacher to correct your work. (You are to get the key answer only after you finished 

answering the Self-check 2). 

11. Read the information written in the ―Information Sheets 3 . Try to understand what are 

being discussed. Ask you teacher for assistance if you have hard time understanding 

them. 

 Accomplish the ―Self-check 3‖ in page 12.    

12. Ask from your teacher the key to correction (key answers) or you can request your 

teacher to correct your work. (You are to get the key answer only after you finished 

answering the Self-check 3). 

13. Read the information written in the ―Information Sheets 4 . Try to understand what are 

being discussed. Ask you teacher for assistance if you have hard time understanding 

them. 

14. Accomplish the ―Self-check 4‖ in page 15.  

15. Ask from your teacher the key to correction (key answers) or you can request your 

teacher to correct your work. (You are to get the key answer only after you finished 

answering the Self-check 4). 

16. Read the information written in the ―Information Sheets 5 . Try to understand what are 

being discussed. Ask you teacher for assistance if you have hard time understanding 

them. 

17. . Accomplish the ―Self-check 5‖ in page 17.  

18. Read the information written in the ―Information Sheets 6 . Try to understand what are 

being discussed. Ask you teacher for assistance if you have hard time understanding 

them. 

19. Accomplish the ―Self-check 6‖ in page 26.  

20. Read the information written in the ―Information Sheets 7 . Try to understand what are 

being discussed. Ask you teacher for assistance if you have hard time understanding 

them. 

21. Accomplish the ―Self-check 7‖ in page 29.  

Read the information written in the “Information Sheets 8 . Try to understand what are being discussed. Ask 

you teacher for assistance if you have hard time understanding 

22. Accomplish the ―Self-check 8‖ in page 31.  

. 

23. Read the ―Operation Sheet 1‖in page 32 and try to understand the procedures 
discussed. 

24. If you earned a satisfactory evaluation proceed to ―Operation Sheet 2‖ in page 33.  
However, if your rating is unsatisfactory, see your teacher for further instructions or go 
back to Learning Activity #1. 

25. Read the ―Operation Sheet 2‖ and try to understand the procedures discussed. 
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26. If you earned a satisfactory evaluation proceed to ―Operation Sheet 3‖ in page 37.  
However, if your rating is unsatisfactory, see your teacher for further instructions or 
go back to Learning Activity #1. 

27. Read the ―Operation Sheet 3‖ and try to understand the procedures discussed. 
28. If you earned a satisfactory evaluation proceed to ―Operation Sheet 4‖ in page 38.  

However, if your rating is unsatisfactory, see your teacher for further instructions or 
go back to Learning Activity #1. 

29. Read the ―Operation Sheet 4‖ and try to understand the procedures discussed 
30. If you earned a satisfactory evaluation proceed to ―Operation Sheet 5‖ in page 50.  

However, if your rating is unsatisfactory, see your teacher for further instructions or 
go back to Learning Activity #1. 

31. Read the ―Operation Sheet 5‖ and try to understand the procedures discussed 
32. If you earned a satisfactory evaluation proceed to ―Operation Sheet 6‖ in page 52.  

However, if your rating is unsatisfactory, see your teacher for further instructions or 
go back to Learning Activity #1. 

33. Read the ―Operation Sheet 6‖ and try to understand the procedures discussed 
34. Do the ―LAP test‖ in page 53 (if you are ready). Request your teacher to evaluate your 

performance and outputs. Your teacher will give you feedback and the evaluation will be 
either satisfactory or unsatisfactory.  If unsatisfactory, your teacher shall advice you on 
additional work. 
 

 
 
 
 
 
 
 

 

 

 

 

 

 

 

The Database Design Principles  
      . Usability: Any information which we are storing in any organization should be 
meaningful for that organization. If we are storing those factors which are actually not fit 
with organization’s requirement then this is just waste of resources. 

 Information Sheet-1 

 

Database Design Principles  
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        Extensibility: As we know that everyday new business requirements come up and 
every day there is a need to change or enhance information system to capture new 
requirements. So information design should be extensible so that it can adopt new 
requirements without much efforts or without major breaking changes. 

        Data Integrity: Now at this point we understand that information is very much important 
for any organization. Based on the historic information, every organization makes different 
strategies, decisions for growth. One small mistake in data can lead to major issues with 
any organization’s key decision and hence a big risk for growth. 

          Entity Integrity: Involves the structure (primary key and its attributes) of the entity. If 

the primary key is unique and all attributes are scalar and fully dependent on the primary 

key, then the integrity of the entity is good. In the physical schema, the table’s primary key 

enforces entity integrity. 

        Domain Integrity: It defines that data should be of correct type and we should handle 

optional data in correct way. We should apply Nullability to those attributes which are 

optional for organization. We can define proper data types for different attributes based on 

organization’s requirement so that correct format data should present in system. 

        Referential Integrity: This defines if any entity is dependent on another one then 

parent entity should be there in the system and should be uniquely identifiable. We can do 

this by implementing foreign keys. 

       User defined integrity: There are few business rules which we cannot validate just by 

primary keys, foreign keys etc. There has to be some mechanism so that we can validate 

complex rules for integrity. We can implement these rules in following ways: 

 
      Performance: As we know that information should be readily available as requested. 
Performance of the system should be up to the mark. As data in increasing day by day so 
at some time there will be impact on performance if database design is poor or we’ll not 
take any actions to improve performance. 

      Availability: The availability of information refers to the information’s accessibility when 
required regarding uptime, locations, and the availability of the data for future analysis. 
Disaster recovery, redundancy, archiving, and network delivery all affect availability. 

        Security: For any organizational asset, the level of security must be secured 

depending on its value and sensitivity. Sometime organizations has suffered a lot because 

of data leaks which results in loss of faith and tends to business risk. So security is one of 

the most important aspect of good database design. 



FTVET Agency                                                                                                                                                                                                      

Training, Teaching and Learning Materials Development                                       

 

 
TTLM Development Manual  Date:  10 2019     Page 6 of 56 
3rd Revision    Author: 1  FTVET AGENCY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Self-Check -1 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next 

page: 
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1. Which  of the following is the basic principle of a database ?(2) 

A. Data Integrity 

B. Extensibility 

C. Usability 

D. All 

2. -------------I Involves the structure (primary key and its attributes) of the entity  (2) 

A. Data integrity 

B. Entity integrity 

C. A&B 

D. None 

3. Which integrity defines  any entity is dependent on another (2) 

A. Data integrity 

B. Referential  

C.  Entity  

D. All of the above 

  

 

 

 

Answer Sheet 

 

 

 

Information Sheet 2 Opening& Designing Database Application 

 Introduction to Database  

 A database can best be described as a way of storing large amounts of 

information.  

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 and 5 points          Unsatisfactory - below 3 and 5 points  

You can ask you teacher for the copy of the correct answers. 
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 The data can be retrieved and we can even ask questions of the data and get 

answers.  

 For example: You may want to know how many Students enrolled in every 

occupational level. 

 MS Access (MS Office Access 2007) is a database management tool that 

enables one to store relevant data.   

 This also has the capabilities to retrieve, sort, summarize report and result 

immediately and effectively.  

 It can combine data from various files (tables) through creating relationships and 

can make data entry more efficient and accurate through the use of forms. 

 Microsoft Access (MS Access) enables to manage all important information from 

a single database file.  

 Within the file, can use the different objects/items: 

 The design process 

 Determine the purpose of your database.    This helps prepare you for the 

remaining steps. 

 Find and organize the information required. Gather all of the types of information 

you might want to record in the database, such as product name and order 

number. 

 Divide the information into tables. Divide your information items into major 

entities or subjects, such as Products or Orders. Each subject then becomes a 

table. 

 Turn information items into columns . Decide what information you want to store 

in each table. Each item becomes a field, and is displayed as a column in the 

table. For example, an Employees table might include fields such as Last Name 

and Hire Date. 

 Specify primary keys. Choose each table’s primary key. The primary key is a 

column that is used to uniquely identify each row. An example might be Product 

ID or Order ID. 

 Set up the table relationships. Look at each table and decide how the data in one 

table is related to the data in other tables. Add fields to tables or create new 

tables to clarify the relationships, as necessary. 
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 Refine your design. Analyze your design for errors. Create the tables and add a 

few records of sample data. See if you can get the results you want from your 

tables. Make adjustments to the design, as needed. 

 Apply the normalization rules. Apply the data normalization rules to see if your 

tables are structured correctly. Make adjustments to the tables, as needed. 

 

 

 

 

 

 

 

 

 

 

 

 

 
Self-Check -2 

 
                Written Test 

 
Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next 

page: 
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            1. Which can be described as a way of storing large amounts of information. (2) 

A. Application 

B. Database 

C. Excel 

D. All 

              2.-------- is a database management tool that enables one to store relevant data.(  2) 

A. Data integrity 

B. MS-Access 

C. A&B 

D. None 

3. ------ is a column that is used to uniquely identify each row (2) 

A. Forigen key 

B. Primary key  

C. A&B  

D. All of the above 

  

 

 

 

Answer Sheet 

 

 

 

 

What does Database Object mean?  

A database object in a relational database is a data structure used to either store or 
reference data. The most common object that people interact with is the table. Other 
objects are indexes, stored procedures, sequences, views and many more.  

Information Sheet:3  Database OBJECTS 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 and 5 points          Unsatisfactory - below 3 and 5 points  

You can ask you teacher for the copy of the correct answers. 
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        When a database object is created, a new object type cannot be created because all 
the various object types created are restricted by the very nature, or source code, of the 
relational database model being used, such as Oracle, SQL Server or Access. What is 
being created is instances of the objects, such as a new table, an index on that table or a 
view on the same table.  

The different type of Database objects 

.  Tables: - Recently, we define it as a file but technically, it was defined as a container or 

a worksheet-like container where the collection of data has been stored.  

   Tables - A table is a collection of data about a specific topic, such as products or 

suppliers 

 Basic Component of a  Table: 

 Meta Data – Database Structure 

 Field – Column – Data 

 Fieldname 

 Record - Row - Information 

 Metadata – is a “data about data” or synonymously called table structure that defines 

what type of data your data is?   

Queries –Queries used to view, change, and analyze data in different ways. You can also 

use them as a source of records for forms, reports. 

Forms - A form is a type of a database object that is primarily used to enter or display data 

in a database. You can also use a form as a switchboard that opens other forms and 

reports in the database, or as a custom dialog box that accepts user input and carries out 

an action based on the input.  

Reports - A report is an effective way to present your data in a printed format. Because 

you have control over the size and appearance of everything on a report,  

 
Self-Check -3 

 
                Written Test 

 
Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next page 
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1. -------provide a means of organizing and summarizing data and used to 

present    your data in a printed format. 

A. Report 

B. Form  

C. Query 

D. Module 

              2. ------- used to view, change, and analyze data in different ways a.(  2) 

                   A. Queries               

                   B. MS-Access 

                   C. A&B 

              3. ----- is a type of a database object that is primarily used to enter or display data  

A. Form 

B. Queries  

C. Table 

 

  

 

 

 

Answer Sheet 

 

 

 

 

 

Information Sheet-4 Creating Data base Objects 

Data Base Tables: - Recently, we define it as a file but technically, it was defined as a 

container or a worksheet-like container where the collection of data has been stored. 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 and 5 points          Unsatisfactory - below 3 and 5 points  

You can ask you teacher for the copy of the correct answers. 
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 Before we proceed to creating your first table, we need to know first the basic 

components of a table: 

 Meta Data – Database Structure 

 Field – Column – Data 

 Fieldname 

 Record - Row - Information 

Data types in Microsoft Access 

 The different kinds of MsAccess2007 data types are:  

 Text: allows for the storage of any kind of data, characters, digits and special 

characters.  

 Memo: is used for texts of more than 255 characters such as comments or 

explanations.  

 Number: for numerical data used in mathematical calculations.  

 Date/Time: for the introduction of date and time from the year 100 to 9999. 

 Currency: For monetary/economic values and numerical data used in 

mathematical calculations in which the data involved contains between one and 

four decimals.  

 Autonumber: a unique sequential number (increasing one by one), or a number 

that Access assigns every time it adds a new record to a table.  

 Yes/No:Yes and No values, and fields that contain one of two values (Yes/No, 

True/False or Activated/Deactivated). 

 OLE Object: an object such as a Microsoft Excel spreadsheet, a Microsoft Word 

document, graphics, images, sounds, or other binaries. 

 Used to embed or link to documents from other programs like Excel and 

Word. 

 Hyperlink: text or a combination of text and numbers stored as text and used as a 

hyperlink address.  

 Attachment: Used to store files in an Access database.  

 The attachment data type lets you store one or more files per record. 

 Lookup wizard…: A lookup wizard field lets the user choose from a predefined set 

of options, like a "male" or "female" selection or a "country" selection.  

http://en.tekstenuitleg.net/articles/software/access-data-types#attachment-data-type
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Designing a table involves: 

 Entering unique names of the columns of the table in the ―field name” column of 

thedesign view. N 

 Names of fields and objects in Microsoft Access can be up to 64characters long.  

 They can include any combination of letters, numbers, spaces, andspecial characters 

except a period (.), an exclamation point (!), an accent grave (`), andbrackets ([ ]). They 

also can't begin with leading spaces. 

Normalization 

 Normalization is the process of efficiently organizing data in a database. 

 There are two goals of the normalization process:  

1. Eliminating redundant data (for example, storing the same data in more than 

one table) and 

2. Ensuring data dependencies make sense (only storing related data in a table).  

 Both of these are valuable goals as they reduce the amount of space a database 

consumes and ensure that data is logically stored. 

 

 

 

 

 

 

 

 

 

 

 
Self-Check -4 

 
                Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next page 

 

http://databases.about.com/library/glossary/bldef-table.htm
http://databases.about.com/od/specificproducts/a/Database-Dependency.htm
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1. -------is  a container or a worksheet-like container where the collection of 

data has been stored .(2) 

A. Data base tables 

B. Form  

C. Query 

D. Module 

                   2.------- Which one of the following is the component of table.(  2) 

                   A. Mete data             

                   B. Field 

                   C. Records 

                   D. All of the above 

                   3.--- --allows for the storage of any kind of data, characters, digits and special 

characters.(2) 

A. Memos 

B. Texts 

C. Number  

D. All of the above 

 

  

 

 

 

Answer Sheet 

 

 

Information Sheet-5 Modifying Database Object 

Modify your new database created from a template 

Every template that is included with Access is a complete tracking application that contains 
predefined tables, forms, reports, queries, macros, and relationships. These templates are 
designed to be immediately useful out-of-the-box, so that you can create a new database 
that is based on a template and get up and running quickly. However, there might be times 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 and 5 points          Unsatisfactory - below 3 and 5 points  

You can ask you teacher for the copy of the correct answers. 
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when you want to modify your new database — for example, to add or rename a field, or 
change a report. You can easily add a field to a table in Datasheet view. However, you can 
also add a field to a table in Design view. To learn more about adding a field to a table in 
Datasheet view, see the article Add or delete a column in a datasheet. When you add a 
new field to a table, the field is not automatically added to your existing forms and reports. 
You must manually add the field to those forms and reports in order for it to appear in them. 

           If possible, you should avoid deleting a field from a database that was generated 
from one of the supplied templates — it is likely that the field is employed in other database 
objects, such as forms and reports. Thus, deleting the field will create consequences when 
you attempt to use the other database objects that employ the field — the database objects 
will not work as expected. You will have to remove any references to the field from all of the 
objects that employ it in order for those other objects to work correctly. 

          When you decide that you must delete a field from a database that was generated 
from a template, you can do so in either Datasheet view or Design view. Remember that if 
other database objects reference the deleted field, you must modify those other objects to 
remove the reference. For example, if a report includes a control that is bound to the 
deleted field and you run the report, an error message appears, because Access cannot 
find the data for the field. 

           Before you can delete a field, you must ensure that it doesn't participate in any table 
relationships. If you try to delete a field for which relationships exist, Access warns you that 
you must first delete the relationships. 

 

 

 

 

 

 

 
Self-Check -5 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next 

page: 

               1 Which one of the following is a database object?(2) 

https://support.office.com/en-us/article/add-or-delete-a-column-in-a-datasheet-02064e10-3fd7-4377-8034-c6f75dc5a12c
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A. Form 

B. Table 

C. Query 

D. All of the above 

2 Before you can delete a field, you must ensure that it doesn't participate in any     

       Table relationships (2) 

A. True 

B. False 

 

 

 

  

 

 

 

Answer Sheet 

 

 

 

 

Information Sheet-6 Create Data base Relation ship 

 Table Relationship 

 Newcomers to the world of databases often have a hard time seeing the 

differences between a database and a spreadsheet.  

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 2 and 4points          Unsatisfactory - below 2 and 1 points  

You can ask you teacher for the copy of the correct answers. 
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 They see tables of data and recognize that databases allow you to organize and 

query data in new ways, but fail to grasp the significance of the relationship that 

gives relational database technology & its name.  

 Relationships allow you to describe the connections between different database 

tables in powerful ways.  

 Once you’ve described the relationships between your tables, you can later 

leverage that information to perform powerful cross-table queries, known as 

joins. 

 A relationship is a logical connection between two tables. 

 Keys are fields that are part of a table relationship. There are two kinds of keys 

 Primary key 

 A table can have only one primary key.  

 A primary key is used to identify each record that you store in the table.  

 It will not allow a duplication of the Primary Key thus make it unique.   

 Primary Key is the unique identification of one record.There is a uniquely 

identification number, such as 

 ID number 

 A serial number 

 A code that serves as a primary key 

 Foreign key  

 A table can also have one or more foreign key.  

 A foreign key contains values that correspondent to values in the primary key of 

another table 

 You use table relationship to combine data from related table 

 

Customer 

c-id 
c-name 
c-age 
c-sex 
c-phone 
c-address 

Employee  
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Primary key   

  Foreign key 

 Types of Database Relationships 

 One-to-one relationships: occur when each entry in the first table has one, 

and only one, counterpart in the second table.  

 One-to-many relationships: Is the most common type of database 

relationship. . 

 Many-to-many relationships: occur when each record in the first table 

corresponds to one or more records in the second table and each record 

in the second table corresponds to one or more records in the first table.  

ER Diagrams (Entity Relationship Diagrams) 

 An Entity Relationship Diagram (ERD) is a visual representation of different data using 

conventions that describe how these data are related to each other.  

 For example, the elements writer, novel, and consumer may be described using ER 

diagrams this way: 

 

 

 

 

 

 

ER diagram with basic objects 

 In the diagram, the elements inside rectangles are called entities while the items inside 

diamonds denote the relationships between entities.  

e- id 
e- name 
e- age 
e- sex 
e- address 
e- salary 

c-id 

http://creately.com/blog/wp-content/uploads/2012/03/ER-Diagram-Example.jpeg
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 This ER diagram tutorial for beginners covers most things related to ER diagram, 

for quick navigation use the links below. 

 ER Diagram Usage 

 ER Diagrams Symbols and Notations 

 How to Draw ER Diagrams 

 ER Diagram Templates 

 Benefits of ER Diagrams 

ER Diagrams Usage 

 ER diagrams are most often associated with complex databases that are used in 

software engineering and IT networks.  

 In particular, ER diagrams are frequently used during the design stage of a 

development process in order to identify different system elements and their 

relationships with each other.  

 For example, inventory software used in a retail shop will have a database that 

monitors elements such as purchases, item, item type, item source and item price. 

Rendering this information through an ER diagram would be something like this: 

 

 

 

 

 

 

ER diagram example with entity having attributes 

In the diagram, the information inside the oval shapes is attributes of a particular entity. 

1.1.1 ER Diagram Symbols and Notations 

 

 

http://creately.com/blog/wp-content/uploads/2012/03/ER-Diagram-Example-2.jpeg
http://creately.com/blog/wp-content/uploads/2012/03/ER-Diagram-Elements.jpeg
http://creately.com/blog/diagrams/er-diagrams-tutorial/#usage
http://creately.com/blog/diagrams/er-diagrams-tutorial/#symbols
http://creately.com/blog/diagrams/er-diagrams-tutorial/#draw
http://creately.com/blog/diagrams/er-diagrams-tutorial/#template
http://creately.com/blog/diagrams/er-diagrams-tutorial/#benefits
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Elements in ER diagrams 

 There are three basic elements in an ER Diagram:  

1. Entity 

2. Attribute 

3. Relationship 

 There are more elements which are based on the main elements.  

 Weak entity 

 Multivalve attribute 

 Derived attribute 

 Weak relationship and  

 Recursive relationship.  

 Cardinality and ordinalily are two other notations used in ER diagrams to further 

define relationships. 

Entity 

 An entity can be a person, place, event, or object that is relevant to a given system.  

 For example, a school system may include students, teachers, major courses, subjects, 

fees, and other items.  

 Entities are represented in ER diagrams by a rectangle and named using singular nouns. 

Weak Entity 

 A weak entity is an entity that depends on the existence of another entity.  

 In more technical terms it can defined as an entity that cannot be identified by its own 

attributes.  

 It uses a foreign key combined with its attributed to form the primary key.  

 An entity like order item is a good example for this. The order item will be meaningless 

without an order so it depends on the existence of order. 

 

Weak Entity Example in ER diagrams 

Attribute 

http://creately.com/blog/wp-content/uploads/2012/03/weak-entity-ER-diagrams.jpeg
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 An attribute is a property, trait, or characteristic of an entity, relationship, or another 

attribute.  

 For example, the attribute Inventory Item Name is an attribute of the entity Inventory 

Item. An entity can have as many attributes as necessary.  

 Meanwhile, attributes can also have their own specific attributes.  

 For example, the attribute ―customer address‖ can have the attributes number, street, 

city, and state.  

 These are called composite attributes.  

 Note that some top level ER diagrams do not show attributes for the sake of simplicity.  

 In those that do, however, attributes are represented by oval shapes. 

 

 

 

 

 

Attributes in ER diagrams, note that an attribute can have its own attributes 

(compositeattribute) 

Multivalued Attribute 

 If an attribute can have more than one value it is called a multivalued attribute. 

 It is important to note that this is different to an attribute having its own attributes. For 

example a teacher entity can have multiple subject values. 

 

Example of a multivalued attribute 

Derived Attribute 

 An attribute based on another attribute.  

 This is found rarely in ER diagrams.  

 For example for a circle the area can be derived from the radius. 

 

http://creately.com/blog/wp-content/uploads/2012/03/Multivalued-Attribute-ER-Diagrams.jpeg
http://creately.com/blog/wp-content/uploads/2012/03/Derived-Attribute-ER-Diagrams.jpeg
http://creately.com/blog/wp-content/uploads/2012/03/Attributes-ER-Diagrams.jpeg
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Derived Attribute in ER diagrams 

Relationship 

 A relationship describes how entities interact.  

 For example, the entity ―carpenter‖ may be related to the entity ―table‖ by the relationship 

―builds‖ or ―makes‖.  

 Relationships are represented by diamond shapes and are labeled using verbs. 

 

Using Relationships in Entity Relationship Diagrams 

Recursive Relationship 

 If the same entity participates more than once in a relationship it is known as a recursive 

relationship.  

 In the below example an employee can be a supervisor and be supervised, so there is a 

recursive relationship. 

 

 

Example of a recursive relationship in ER diagrams 

Cardinality and Ordinality 

 These two further defines relationships between entities by placing the relationship in the 

context of numbers.  

 In an email system, for example, one account can have multiple contacts.  

 The relationship in this case follows a ―one to many‖ model.  

 There are number of notations used to present cardinality in ER diagrams.  

 Chen, UML, Crow’s foot, Bachman are some of the popular notations. Creately supports 

Chen, UML and Crow’s foot notations.The following example uses UML to show 

cardinality. 

http://creately.com/blog/wp-content/uploads/2012/03/Recursive-Relationship-ER-Diagrams.jpeg
http://creately.com/blog/wp-content/uploads/2012/03/Relationship-ER-diagrams.jpeg
http://creately.com/
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Cardinality in ER diagrams using UML notation 

1.1.2 ER Diagram Templates 

 Below are some ER diagram templates so you can get started quickly.  

 Clicking on the image and in the new page that opens click the ―Use as Template‖ 

button.  

 For more templates check out ER diagram templates article. 

 

ER Diagram Template of exam database (Click on the image to use as template) 

http://creately.com/blog/examples/er-diagram-templates/
http://creately.com/blog/wp-content/uploads/2012/03/Cardinality-ER-Diagrams.jpeg
http://creately.com/diagram/example/gsv8l5hs2/Exam+Database
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 A basic ER diagram template for a quick start

 

Basic ER Diagram template (Click to use as template) 

1.1.3 Benefits of ER diagrams 

 ER diagrams constitute a very useful framework for creating and manipulating 

databases.  

 First, ER diagrams are easy to understand and do not require a person to undergo 

extensive training to be able to work with it efficiently and accurately.  

 This means that designers can use ER diagrams to easily communicate with developers, 

customers, and end users, regardless of their IT proficiency.  

 Second, ER diagrams are readily translatable into relational tables which can be used to 

quickly build databases.  

 In addition, ER diagrams can directly be used by database developers as the blueprint 

for implementing data in specific software applications.  

 Lastly, ER diagrams may be applied in other contexts such as describing the different 

relationships and operations within an organization. 

http://creately.com/diagram/example/gstx57ng2/Database+of+a+Surgeon
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Self-Check -6 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next page: 

 

              1. The relation between course to student is  

                   A. One - to – one                

                    B. Many - to - one       

                    C. One - to – many       

                    D. Many - to – Many 

                 2. Which one of the following is true about the primary key? 

                           A. Should Not Null      

                           B. It should be both Null and not Null 

                           C. It should be Null             

                           D.   Cannot have character data type    

                   3. ----describes how entities are related and it help to view information from two or                                     

more table at the same time. 

                            A. Entity      

                            B. Form  

                            C. Table  

                            D. Relationship 

 

 

  

 

 

 

Answer Sheet 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 and 5 points          Unsatisfactory - below 3 and 5 points  

You can ask you teacher for the copy of the correct answers. 
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Information Sheet-7 Adding ,Modifying& Deleting  Records 

Ways to Add, Edit, and Delete records 

         There are several ways to update data in an Access database. You add a record to your 
database when you have a new item to track, such as a new contact to the Contacts table. 
When you add a new record, Access appends the record to the end of the table. You also 
change fields to stay up-to-date, such as a new address or last name. To maintain data 
integrity, the fields in an Access database are set to accept a specific type of data, such as 
text or numbers. If you don't enter the correct data type, Access displays an error message. 
Finally, you can delete a record when it is no longer relevant and to save space. 

        You use a form to manually update data. Data entry forms can provide an easier, faster, 
and more accurate way to enter data. Forms can contain any number of controls such as lists, 
text boxes, and buttons. In turn, each of the controls on the form either reads data from or 
writes data to an underlying table field. 

 

Datasheets are grids of data that look like Excel worksheets. You can change data by working 
directly in Datasheet view. If you are familiar with Excel, datasheets should be relatively easy 
to understand. You can change data in tables, query result sets, and forms that display 
datasheets. Typically, you use datasheets when you need to see many records at once. 

 

Understanding data entry symbols 

The following table shows some of the record selector symbols you might see when updating 
data and what they mean. 

Symbol  Meaning  

 

This is the current record; the record has been saved as it appears. The current 
record is indicated by a change in color in the record selector. 
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Symbol  Meaning  

 

You are editing this record; changes to the record aren't yet saved. 

 

This record is locked by another user; you can't edit it. 

 

This is a new record in which you can enter information. 

 

This is the primary key field and contains a value that uniquely identifies the record. 
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Self-Check -7 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next 

page: 

 

1. Describe the reason why we add, modify and delete data records (5) 

2. Describe about data entry forms (5) 

 

 

 

 

 

 

 

Answer Sheet 

 

 

 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 5 and 10 points          Unsatisfactory - below 5   

You can ask you teacher for the copy of the correct answers. 
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Information Sheet 8 
Saving a database or an object in a different format:  

Saving a database  

       Saving your work in Access is a little different from saving in most Office apps. Changes 

to data, the primary reason for saving your work in most apps, are automatically saved in In 

Access, instead of saving data changes, you save changes to the database design, or you 

save the whole database, data and all, with a new filename as a backup, or in a different 

format, such as an earlier Access file format, a database template, or a compiled database (a 

database where you can't change the design). You can also save individual database objects 

as new objects. 
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Self-Check -8 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next page: 

 

3. To retrieve Information Saving is important(3) 

A. True 

B. False 

4. Saving your work in Access is a little different from saving in most Office 

apps.(3) 

A. False 

B. True 

 

 
                    

 

 

  

 

 

 

Answer Sheet 

 

 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 and 5 points          Unsatisfactory - below 3 and 5 points  

You can ask you teacher for the copy of the correct answers. 
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 Steps to create Create a blank database 

On the Getting Started with Microsoft Office Access page, under New Blank Database,  

click Blank Database. 

 

 

 In the Blank Database pane, type a file name in the File Name box. If you do not 

supply a file name extension, Access adds it for you. To change the location of the 

file from the default, click Browse for a location to put your database  (next to 

the File Name box), browse to the new location, and then click OK. 

 Click Create. 

 Access creates the database with an empty table named Table1, and then opens 

Table1 in Datasheet view. The cursor is placed in the first empty cell in the Add 

New Field column. 

 Begin typing to add data, or you can paste data from another source, as described 

in the section Copy data from another source into an Access table. 

 

 Steps to Open an existing Access database 

 Click the Microsoft Office Button ,  

  click Open.In the Open dialog box, browse to the database that you want to open. 

  Double-click the database to open it in the default mode specified in the Access      

 Options dialog box or the mode that was set by an administrative policy. 

 Click Open to open the database for shared access in a multi-user environment so 

that you and other users can read and write to the database. 
 Click the arrow next to the Open button and then click Open Read-Only to open the 

database for read-only access so that you can view but not edit it. Other users can 

still read and write to the database. 

 Click the arrow next to the Open button  

  click Open Exclusive to open the database with exclusive access. When you have 

a database open with exclusive access, anyone else who tries to open the 

database receives a "file already in use" message. 

Opening and designing DB application and principles 

 

Operation Sheet1 

http://office.microsoft.com/en-us/access-help/create-a-new-database-HA010037837.aspx#BMpastedata
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 Steps to Create a new table in a new database 

 Click the Microsoft Office Button , and then click New. 

 In the File Name box, type a file name for the new database. 

 To browse to a different location to save the database, click the folder icon. 

 Click Create. 

 Steps to Create a new table in an existing database 

 Click the Microsoft Office Button , and then click Open. 

 In the Open dialog box, select the database that you want to open, and then 

click Open. 

 On the Create tab, in the Tables group, click Table. 

 Steps to Create a new table by using a table template 

 Click the Microsoft Office Button , and then click Open. 

 In the Open dialog box, select and open the database in which you wish to create a 

table. 

 On the Create tab, in the Tables group, click Table Templates and then select one 

of the available templates from the list. 

 

 StepsTo Create a new table by importing or linking to external data 

 Click the Microsoft Office Button , and then click Open. 

 In the Open dialog box, select and open the database in which you wish to 

create a new table. 

Operation Sheet-2 Creating Database Objects (Tables ) 
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 On the External Data tab, in the Import group, click one of the available data 

sources. 

 

 Follow the instructions in the dialog boxes that appear at each step. 

 Steps to Use a SharePoint site to create a table 

 Click the Microsoft Office Button , and then click Open. 

 In the Open dialog box, select the database in which you want to create the new 

table, and then click Open. 

 On the Create tab, in the Tables group, click SharePoint Lists. 

 Steps to Create a SharePoint list that is based on a template 

 Click either Contacts, Tasks, Issues, or Events. 

 In the Create New List dialog box, type the URL for the SharePoint site where 

you want to create the list. 

 Enter a name for the new list and its description in the Specify a name for the 

new list and Description boxes. 

 To open the linked table after it is created, select the Open the list when 

finished check box (selected by default). 

 Steps to Create a new custom list 

 Click Custom. 

 In the Create New List dialog box, type the URL for the SharePoint site 

where you want to create the list. 

 Enter a name for the new list and its description in the Specify a name for 

the new list and Description boxes. 
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 To open the linked table after it is created, select the Open the list when 

finished check box (selected by default). 

 Steps to import the data from an existing list 

 Click Existing SharePoint List. 

 In the Get External Data dialog box, type the URL for the SharePoint site that 

contains the data that you want to import. 

 Click Import the source data into a new table in the current database, and then 

click Next. 

 Select the check box next to each SharePoint list that you want to import. 

 Steps to Link to an existing list 

 Click Existing SharePoint List. 

 In the Get External Data - SharePoint Site dialog box, type the URL for the 

SharePoint site that contains the list to which you want to link. 

 Click Link to the data source by creating a linked table, and then click Next. 

 Select the check box next to each SharePoint list to which you want to link. 

 Steps to set or change  a table's primary key 

 Select the table whose primary key you want to set or change. 

 On the Home tab, in the Views group, click View, and then click Design View. 

 In the table design grid, select the field or fields that you want to use as the 

primary key. 

 On the Design tab, in the Tools group, click Primary Key. 

 A key indicator appears to the left of the field or fields that you specify as the 

primary key. 

 Steps to Remove the primary key 

 Select the table whose primary key you want to remove. 

 On the Home tab, in the Views group, click View, and then click Design View. 

 Click the row selector for the current primary key. If the primary key consists of 

multiple fields, hold down CTRL, and then click the row selector for each field. 

javascript:AppendPopup(this,'178078404_6')
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 On the Design tab, in the Tools group, click Primary Key. 

 Steps to Set a table's properties 

 Select the table whose properties you want to set. 

 On the Home tab, in the Views group, click View, and then click Design View. 

 On the Design tab, in the Show/Hide group, click Property Sheet.The table 

property sheet is shown. 

 On the property sheet, click the General tab. 

 Click the box to the left of the property that you want to set, and then enter a 

setting for the property. 

 To save your changes, press CTRL+S. 

 Steps to Add a field by using a field template 

 On the Home tab, in the Views group, click View, and then click Datasheet 

View. 

 On the Datasheet tab, in the Fields & Columns group, click New Field. 

 Select one or more fields in the Field Templates pane, and then drag them to 

the table where you want to insert the new column. 

 Steps to Open a table in Datasheet view 

 In the Navigation Pane, right-click the table that you want to open. 

 On the shortcut menu, click Datasheet view. 

 Steps to Rename a field 

 Right-click the heading of the field that you want to rename (for example, 

Field1). 

 On the shortcut menu, click Rename Column. 

 Enter the new name in the field heading. 

 Steps to Change a field's data type 

 On the Ribbon, click the Datasheet tab . 

 In the Data Type list, in the Data Type & Formatting group, select the data type 

that you want. 
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 Steps to Set other field properties 

 In Datasheet view, click the field for which you want to set the property. 

 On the Datasheet tab, in the Data Type & Formatting group, select the 

properties that you want. 

 Steps to Set field properties in Design view 

 Open a table in Design view 

 In the Navigation Pane, right-click the table. 

 On the shortcut menu, click Design view. 

 Change a field's data type 

 In the table design grid, locate the field for which you want to set the data type. 

 In the Data Type column, choose a data type from the list. 

 To save your changes, press CTRL+S. 

 Find links to more information about data types and field properties in the See 

Also section. 
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Operation Sheet3 Modifying Database Objects 

 Turn on the Name AutoCorrect option 

 Click File > Options.  
 In the Access Options dialog box, in the left pane, click Current Database. 
 Under Name AutoCorrect Options, select the Track name AutoCorrect info 

check box, and then select the Perform name AutoCorrect check box. 
 If you want to keep a table that logs each change that is performed by Name 

AutoCorrect, select the Log name AutoCorrect changes check box. 
 Click OK. 
 To save your changes, click Save on the Quick Access Toolbar. 

 Rename a field in Datasheet view 

 In the Navigation Pane, double-click the table in which you want to rename 
the field. 

o The table is opened in Datasheet view. 
 Right-click the column heading for the field that you want to rename, and 

then click Rename Field on the shortcut menu. 
 Type the new name for the field and then press ENTER. 

 Rename a field in Design view 

 In the Navigation Pane, right-click the table in which you want to rename the 
field, and then click Design View on the shortcut menu.. 

 Click the cell in the Field Name column for the field that you want to rename. 
 Edit the text to rename the field. 
 To save your changes, click Save on the Quick Access Toolbar. 

 Rename a table 

 In the Navigation Pane, right-click the table that you want to rename ,and 
then click Rename on the shortcut menu. 

 Type the new name and then press ENTER. 
 To save your changes, click Save on the Quick Access Toolbar. 

 Change the text that appears in a column heading 

 In the Navigation Pane, right-click the table in which you want to change the 
caption, and then click Design View on the shortcut menu. 

 Click the cell in the Field Name column for the field whose Caption property 
you want to set. 

 In the bottom section, under Field Properties, on the General tab, click 
Caption. 

 Type a new caption for the field. 
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 To save your changes, click Save on the Quick Access Toolbar. 
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  

Create, edit or delete a relationship 

After you have created a table for each subject in your database, you must provide Office 

Access 2007 with the means by which to bring that information back together again when 

needed. You do this by placing common fields in tables that are related, and by defining table 

relationships between your tables. You can then create queries, forms, and reports that 

display  

 

 Steps to Create a table relationship by using the Relationships document tab 

 Click the Microsoft Office Button , and then click Open. 

 In the Open dialog box, select and open the database. 

 On the Database Tools tab, in the Show/Hide group, click Relationships. 

 

4. If you have not yet defined any relationships, the Show Table dialog box automatically 

appears. If it does not appear, on the Design tab, in the Relationships group, click Show 

Table. 

 

The Show Table dialog box displays all of the tables and queries in the database. To see only 

tables, click Tables. To see only queries, click Queries. To see both, click Both. 

5. Select one or more tables or queries and then click Add. After you have finished adding tables 

and queries to the Relationships document tab, click Close. 

6. Drag a field (typically the primary key) from one table to the common field (the foreign key) in 

the other table. To drag multiple fields, press the CTRL key, click each field, and then drag 

them. 

The Edit Relationships dialog box appears. 

Operation Sheet-4 Creating Database Relationship 
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7. Verify that the field names shown are the common fields for the relationship. If a field name is 

incorrect, click on the field name and select the appropriate field from the list. 

To enforce referential integrity for this relationship, select the Enforce Referential 

Integrity check box. For more information about referential integrity, see the section Enforce 

Referential Integrity 

8. Click Create. 

Access draws a relationship line between the two tables. If you selected the Enforce 

Referential Integrity check box, the line appears thicker at each end. In addition, again only if 

you selected the Enforce Referential Integrity check box, the number 1 appears over the thick 

portion on one side of the relationship line, and the infinity symbol (∞) appears over the thick 

portion on the on the other side of the line, as shown in the following figure. 

 

 NOTES  

http://office.microsoft.com/en-us/access-help/create-edit-or-delete-a-relationship-HA010072597.aspx#BM9
http://office.microsoft.com/en-us/access-help/create-edit-or-delete-a-relationship-HA010072597.aspx#BM9
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 To create a one-to-one relationship    Both of the common fields (typically the primary key and 

foreign key fields) must have a unique index. This means that the Indexed property for these 

fields should be set to Yes (No Duplicates). If both fields have a unique index, Access creates 

a one-to-one relationship. 

 To create a one-to-many relationship    The field on the one side (typically the primary key) of 

the relationship must have a unique index. This means that the Indexed property for this field 

should be set to Yes (No Duplicates). The field on the many side should not have a unique 

index. It can have an index, but it must allow duplicates. This means that the Indexed property 

for this field should be set to either No or Yes (Duplicates OK). When one field has a unique 

index, and the other does not, Access creates a one-to-many relationship. 

Create a table relationship by using the Field List pane 

In Office Access 2007, you can add a field to an existing table that is open in Datasheet view 

by dragging it from the Field List pane. The Field List pane shows fields available in related 

tables and also fields available in other tables in the database. When you drag a field from an 

"other" (unrelated) table and then complete the Lookup Wizard, a new one-to-many 

relationship is automatically created between the table in the Field List pane and the table to 

which you dragged the field. This relationship, created by Access, does not enforce referential 

integrity by default. To enforce referential integrity, you must edit the relationship. See the 

section Edit a table relationship for more information. 

Open a table in Datasheet view 

1. Click the Microsoft Office Button , and then click Open. 

2. In the Open dialog box, select and open the database. 

3. In the Navigation Pane, right-click the table to which you want to add the field and create the 

relationship, and then click Datasheet View on the shortcut menu. 

Open the Field List pane 

 On the Datasheet tab, in the Fields & Columns group, click Add Existing Fields. 

 

 

Steps to Add a field and create a relationship from the Field List pane 

 

1. On the Datasheet tab, in the Fields & Columns group, click Add Existing Fields. 

http://office.microsoft.com/en-us/access-help/create-edit-or-delete-a-relationship-HA010072597.aspx#BM8
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The Field List pane appears. 

2. Under Fields available in other tables, click the plus sign (+) next to a table name to display 

the list of fields in that table. 

3. Drag the field that you want from the Field List pane to the table that is open in Datasheet 

view. 

4. When the insertion line appears, drop the field into position. 

The Lookup Wizard starts. 

5. Follow the instructions to complete the Lookup Wizard. 

The field appears in the table in Datasheet view. 

When you drag a field from an "other" (unrelated) table and then complete the Lookup Wizard, 

a new one-to-many relationship is automatically created between the table in the Field 

List and the table to which you dragged the field. This relationship, created by Access, does 

not enforce referential integrity by default. To enforce referential integrity, you must edit the 

relationship. See the section Edit a table relationship for more information.Steps to Edit a 

table relationship 

You change a table relationship by selecting it in the Relationships document tab and then 

editing it. 

1. Carefully position the cursor so that it points to the relationship line, and then click the line to 

select it. 

The relationship line appears thicker when it is selected. 

2. With the relationship line selected, double-click it.  –or– 

On the Design tab, in the Tools group, click Edit Relationships. 

The Edit Relationships dialog box appears. 

Open the Edit Relationships dialog box 

1. Click the Microsoft Office Button , and then click Open. 

http://office.microsoft.com/en-us/access-help/create-edit-or-delete-a-relationship-HA010072597.aspx#BM8
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2. In the Open dialog box, select and open the database. 

3. On the Database Tools tab, in the Show/Hide group, click Relationships. 

The Relationships document tab appears. 

If you have not yet defined any relationships and this is the first time you are opening the 

Relationships document tab, the Show Table dialog box appears. If the dialog box appears, 

click Close. 

4. On the Design tab, in the Relationships group, click All Relationships. 

 

All tables with relationships are displayed, showing relationship lines. Note that hidden tables 

(tables for which theHidden check box in the table's Properties dialog box is selected) and 

their relationships will not be shown unless Show Hidden Objects is selected in the Navigation 

Options dialog box. 

For more information about the Show Hidden Objects option, see the article Guide to the 

Navigation Pane. 

5. Click the relationship line for the relationship that you want to change. The relationship line 

appears thicker when it is selected. 

6. Double-click the relationship line.   -or- 

On the Design tab, in the Tools group, click Edit Relationships. 

The Edit Relationships dialog box appears. 

http://office.microsoft.com/en-us/access-help/redir/HA001213879.aspx?CTT=5&origin=HA010072597
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7. Make your changes, and then click OK. 

The Edit Relationships dialog box allows you to change a table relationship. Specifically, you 

can change the tables or queries on either side of the relationship, or the fields on either side. 

You can also set the join type, or enforce referential integrity and choose a cascade option. 

For more information about the join type and how to set it, see the section Set the join type. 

For more information about how to enforce referential integrity and choose a cascade option, 

see the section Enforce referential integrity. 

Set the join type 

You should think about the result you will most often want from a query that joins the tables in 

this relationship, and then set the join type accordingly. 

Set the join type 

1. In the Edit Relationships dialog box, click Join Type. 

The Join Properties dialog box appears. 

2. Click your choice, and then click OK. 

The following table (using the Customers and Orders tables) shows the three choices that are 

displayed in the Join Properties dialog box, the type of join they use, and whether all rows or 

matching rows are returned for each table. 

CHOICE RELATIONAL 

JOIN 

LEFT 

TABLE 

RIGHT 

TABLE 

1. Only include rows where the joined fields from Inner join Matching Matching 

http://office.microsoft.com/en-us/access-help/create-edit-or-delete-a-relationship-HA010072597.aspx#BMsetjoin
http://office.microsoft.com/en-us/access-help/create-edit-or-delete-a-relationship-HA010072597.aspx#BM9


Ethiopian TVET System 
Training, Teaching and Learning Material 

 
TTLM Development Manual  Date:  09 2019      Page 46 of 56 
3rd Revision    Author: 1  FTVET AGENCY 

both tables are equal. rows rows 

2. Include ALL records from 'Customers' and only 

those records from 'Orders' where the joined fields 

are equal. 

Left outer join All rows Matching 

rows 

3. Include ALL records from 'Orders' and only 

those records from 'Customers' where the joined 

fields are equal. 

Right outer join Matching 

rows 

All rows 

When you choose option 2 or option 3, an arrow is shown on the relationship line. This arrow 

points to the side of the relationship that shows only matching rows. 

Make changes in the Join Properties dialog box 

1. Click the Microsoft Office Button , and then click Open. 

2. In the Open dialog box, select and open the database. 

3. On the Database Tools tab, in the Show/Hide group, click Relationships. 

 

The Relationships document tab appears. 

If you have not yet defined any relationships and this is the first time you are opening the 

Relationships document tab, the Show Table dialog box appears. If the dialog box appears, 

click Close. 

4. On the Design tab, in the Relationships group, click All Relationships. 

 

All tables that have relationships are displayed, showing relationship lines. Note that hidden 

tables (tables for which the Hidden check box in the table's Properties dialog box is selected) 

and their relationships will not be shown unless Show Hidden Objects is selected in 

the Navigation Options dialog box. 
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For more information about the Show Hidden Objects option, see the article Guide to the 

Navigation Pane. 

5. Click the relationship line for the relationship that you want to change. The relationship line 

appears thicker when it is selected. 

6. Double-click the relationship line.  -or- 

On the Design tab, in the Tools group, click Edit Relationships. 

The Edit Relationships dialog box appears. 

7. Click Join Type 

8. In the Join Properties dialog box, click an option, and then click OK. 

 

9. Make any additional changes to the relationship, and then click OK. 

 

To Turn referential integrity on or off 

1. Click the Microsoft Office Button , and then click Open. 

2. In the Open dialog box, select and open the database. 

3. On the Database Tools tab, in the Show/Hide group, click Relationships. 

 

The Relationships document tab appears. 

If you have not yet defined any relationships and this is the first time you are opening the 

Relationships document tab, the Show Table dialog box appears. If the dialog box appears, 

click Close. 

http://office.microsoft.com/en-us/access-help/redir/HA001213879.aspx?CTT=5&origin=HA010072597
http://office.microsoft.com/en-us/access-help/redir/HA001213879.aspx?CTT=5&origin=HA010072597
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4. On the Design tab, in the Relationships group, click All Relationships. 

All tables with relationships are displayed, showing relationship lines. Note that hidden tables 

(tables for which the Hidden check box in the table's Properties dialog box is selected) and 

their relationships will not be shown unless Show Hidden Objects is selected in the Navigation 

Options dialog box. 

For more information about the Show Hidden Objects option, see the article Guide to the 

Navigation Pane. 

5. Click the relationship line for the relationship that you want to change. The relationship line 

appears thicker when it is selected. 

6. Double-click the relationship line.    -or- 

On the Design tab, in the Tools group, click Edit Relationships. 

The Edit Relationships dialog box appears. 

7. Check Enforce Referential Integrity. 

8. Make any additional changes to the relationship, and then click OK. 

After you have enforced referential integrity, the following rules apply: 

 You cannot enter a value in the foreign key field of a related table if that value doesn't exist in 

the primary key field of the primary table — doing so creates orphan records. 

 You cannot delete a record from a primary table if matching records exist in a related table. 

For example, you cannot delete an employee record from the Employees table if there are 

orders assigned to that employee in the Orders table. You can, however, choose to delete a 

primary record and all related records in one operation by selecting the Cascade Delete 

Related Records check box. 

 You cannot change a primary key value in the primary table if doing so would create orphan 

records. For example, you cannot change an order number in the Orders table if there are line 

items assigned to that order in the Order Details table. You can, however, choose to update a 

primary record and all related records in one operation by selecting the Cascade Update 

Related Fields check box. 

 The common field from the primary table must be a primary key or have a unique index. 

 The common fields must have the same data type. The one exception is that an AutoNumber 

field can be related to a Number field that has a FieldSize property setting of Long Integer. 

 Both tables exist in the same Access database. Referential integrity cannot be enforced on 

linked tables. However, if the source tables are in Access format, you can open the database 

in which they are stored and enable referential integrity in that database. 

http://office.microsoft.com/en-us/access-help/redir/HA001213879.aspx?CTT=5&origin=HA010072597
http://office.microsoft.com/en-us/access-help/redir/HA001213879.aspx?CTT=5&origin=HA010072597
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 Steps to Turn cascade update and/or cascade delete on or off 

 Click the Microsoft Office Button , and then click Open. 

 In the Open dialog box, select and open the database. 

 On the Database Tools tab, in the Show/Hide group, click Relationships. 

 

 

The Relationships document tab appears. 

If you have not yet defined any relationships and this is the first time you are opening the 

Relationships document tab, the Show Table dialog box appears. If the dialog box appears, 

click Close. 

 On the Design tab, in the Relationships group, click All Relationships. 

 All tables that have relationships are displayed, showing relationship lines. Note 

that hidden tables (tables for which the Hidden check box in the 

table's Properties dialog box is selected) and their relationships will not be shown 

unless Show Hidden Objects is selected in the Navigation Options dialog box. 

 For more information about the Show Hidden Objects option, see the article Guide 

to the Navigation Pane. 

 Click the relationship line for the relationship that you want to change. The 

relationship line appears thicker when it is selected. 

 Double-click the relationship line.    -or- 

 On the Design tab, in the Tools group, click Edit Relationships. 

 The Edit Relationships dialog box appears. 

 Select the Enforce Referential Integrity check box. 

 Select either the Cascade Update Related Fields or the Cascade Delete Related 

Records check box, or select both. 

 Make any additional changes to the relationship, and then click OK. 

 Steps to delete a table relationship 

 To remove a table relationship, you must delete the relationship line in the 

Relationships document tab. Carefully position the cursor so that it points to the 

relationship line, and then click the line. The relationship line appears thicker when 

it is selected. With the relationship line selected, press DELETE. Note that when 

you remove a relationship, you also remove referential integrity support for that 

http://office.microsoft.com/en-us/access-help/redir/HA001213879.aspx?CTT=5&origin=HA010072597
http://office.microsoft.com/en-us/access-help/redir/HA001213879.aspx?CTT=5&origin=HA010072597
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relationship, if it is enabled. As a result, Access will no longer automatically prevent 

the creation of orphan records on the "many" side of a relationship. 

 Click the Microsoft Office Button , and then click Open. 

 In the Open dialog box, select and open the database. 

 On the Database Tools tab, in the Show/Hide group, click Relationships. 

 

 The Relationships document tab appears. 

 If you have not yet defined any relationships and this is the first time you are 

opening the Relationships document tab, the Show Table dialog box appears. If the 

dialog box appears, click Close. 

 On the Design tab, in the Relationships group, click All Relationships. 

 For more information about the Show Hidden Objects option, see the article Guide 

to the Navigation Pane. 

 Click the relationship line for the relationship that you want to delete. The 

relationship line appears thicker when it is selected. 

 Press the DELETE key.  -or- 

 Right-click and then click DELETE. 

 Access might display the message Are you sure you want to permanently delete 

the selected relationship from your database?. If this confirmation message 

appears, click Yes. 

 

 

 

 

 

 

 

 

 

 

http://office.microsoft.com/en-us/access-help/redir/HA001213879.aspx?CTT=5&origin=HA010072597
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Operation Sheet 5 Adding ,Modifying Deleting Records 

 Add a record to a table or form 

 Open the table in Datasheet View or the form in Form View. 
 On the Home tab, in the Records group, click New, or click New (blank) record, or 

press Ctrl+Plus Sign (+). 
 Find the record with an asterisk in the record selector, and enter your new 

information. 
 Click or otherwise place the focus on the first field that you want to use, and then 

enter your data. 
 To move to the next field in the same row, press TAB, use the Right or Left arrow 

keys, or click the cell in the next field. 
 When you view another record or close the table or form, Access saves the new 

record that you added. To explicitly save changes to the current record, press 
Shift+Enter. 

 To Delete a record 

The deletion process is fairly simple, except when the record is related to other data and 
resides on the "one" side of a one-to-many relationship. To maintain data integrity, by default, 
Access does not let you to delete related data. For more information, see Guide to table 
relationships. 
Open the table in Datasheet View or form in For 

 m View. 
 Select the record or records that you want to delete. 
 Press DELETE, select Home > Records > Delete, or press Ctrl+Minus Sign  

 To Edit data in a text box or field 

 Open the table or query in Datasheet View or form in Form View. 
 Click the field or navigate to the field by using the TAB or arrow keys, and then 

press F2. 
 Place the cursor where In Form view, you can click a field's label to select the field. 

In you want to enter information. 
 Enter or update the text that you want to insert. If you make a typing mistake, press 

BACKSPACE. 
  If a field has an input mask, enter the data according to the format. 

 

 

https://support.office.com/en-us/article/guide-to-table-relationships-55b8db2c-9480-4269-b1bb-f6ec09623dfd
https://support.office.com/en-us/article/guide-to-table-relationships-55b8db2c-9480-4269-b1bb-f6ec09623dfd
https://support.office.com/en-us/article/control-data-entry-formats-with-input-masks-e125997a-7791-49e5-8672-4a47832de8da


Ethiopian TVET System 
Training, Teaching and Learning Material 

 
TTLM Development Manual  Date:  09 2019      Page 52 of 56 
3rd Revision    Author: 1  FTVET AGENCY 

Operation Sheet 6 Saving & Compiling Database Objects 

 To reuse a database or a database object 

 Open the database or database object. 

 On the File tab, click Save As.  

 Do one of the following steps: 

o To save a database in a different format, click Save Database As.  

o To save a database object in a different format, click Save Object As. 

 Note: The option Save As Client Object is only available in a web database. 

 Click the format you want to use for the new copy. 

 

 

 

 

 

 

 

 

 

 

 

 

 



Ethiopian TVET System 
Training, Teaching and Learning Material 

 
TTLM Development Manual  Date:  09 2019      Page 53 of 56 
3rd Revision    Author: 1  FTVET AGENCY 

 

 

 

Name: ______________________________________  Date: 

________________________________________ 
 

Time started: _______________________________  Time finished: 

_______________________________ 

Task 1 

o Show all the necessary steps & ways to open new MS Access 2007 Database. (5 

Points) 

 

o Show all the necessary steps to open Existing MS Access 2007 Database. (5 

Points) 

 

      Task 2 

 Create a new table in a new database 

 Create a new table in an existing database 

 Create a new table by using a table template 

 Create a new table by importing/linking to external data 

o Set a table's primary key 

o Set or change the primary key 

o Remove the primary key 

 Set a table's properties 

 Table field 

o Add a field to a table 

o Add a field by entering data 

o Add a field by using a field template 

o Add a field from an existing table 

o Set field properties 

 

LAP Test  Practical Demonstration 
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 Task 3 

 Rename a table 

 Change the text that appears in a column heading 

 Task4    

First Create a Database name By ABC and Create the tables Below  

 Creating a table called TblStudent that has fields with data typeas shown 
below : 

- StudentID(Type=Text, Size=10, Primary Key) 

- StudentName(Type=Text,Size=20, Require=Yes) 

- Sex(Type=Text,Size=1,Require=Yes) 

- DOB(Type=Date/Time,Format=dd/mm/yy) 

- Address(Type=Text,Size=Default, Requre=Yes) 

- Photo(Type=Text) 

- Phone(Type=Text) 

 Creating a table called TblTeacher that has fields with data type as shown 
below : 

- TecherID(Type=Text, Size=10, Primary Key) 

- TeacherName(Type=Text,Size=20, Require=Yes) 

- Sex(Type=Text,Size=1,Require=Yes) 

- Address(Type=Text,Size=Default, Requre=Yes)  

- Photo(Type=OLE Object) 

- Phone(Type=Text) 

 Creating a table called TblSubject that has fields with data type as shown 
below : 

- SubjectID(Type=Text, Size=10, Primary Key) 

- SubjectName(Type=Text,Size=30, Require=Yes) 

- Hour(Type=Text,Size=20) 

- Description(Type=Memo) 

- Fee(Type=Currency) 

 Creating a table called TblLab that has fields with data type as shown below : 
- LabID(Type=Text, Size=10, Primary Key) 

- LabName(Type=Text,Size=30, Require=Yes) 

- Capacity(Type=Number) 

 Creating a table called TblTime that has fields with data type as shown below 
: 

- TimeID(AutoNumber,Primary Key) 

- TimeAvailable(Type=Text,Size=20) 

 Creating a table called TblStudy that has fields with data type as shown 
below : 
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- StudyID(Type=Text, Size=10, Primary Key) 

- StudentID(Type=Text, Size=10) 

- TecherID(Type=Text, Size=10) 

- StartDate(Type=Date/Time(dd/mm/yy)) 

- EndDate(Type=Date/Time(dd/mm/yy)) 

- Finished(Type=Yes/No) 

- GetCertificate(Type=Text,Size=50) 

 Creating a table called TblStudyDetail that has fields with data type as shown 
below : 

- StudyDetailID(AutoNumber,Primary Key) 

- StudyID (Number) 

- SubjectID (Type=Text, Size=10) 

- TimeID(Number) 

- LabID(Type=Text, Size=10) 

 After you created all tables already, build the relationships between table and 
table as figure below. 

 

 Task 5 

 Open an existing table & perform the following 

 Add abebe, taye& kebede in the field first name 

 Rename the name aster by astuka 

 Change the Salary 2500 by 4300 in the salary field 

 Task 6 

 Save your file by giving a file name tvetTraining 
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